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Abstract  31 

A major endeavour of systems biology is the construction of graphical and computational models of 32 

biological pathways as a means to better understand their structure and function. Here, we present a 33 

protocol for a biologist-friendly graphical modelling scheme which facilitates the construction of detailed 34 

network diagrams, summarising the components of a biological pathway (such as proteins, biochemicals 35 

etc.) and how they interact. These diagrams can then be used to simulate activity flow through a pathway, 36 

thereby modelling its dynamic behaviour. The protocol is divided into four sections: 1) Assembly of 37 

network diagrams using the modified Edinburgh Pathway Notation (mEPN) scheme and yEd network 38 

editing software using pathway information obtained from published literature and databases of molecular 39 

interaction data, 2) parameterisation of the pathway model within yEd through the placement of ‘tokens’ 40 

based on the known or imputed amount or activity of a component, 3) model testing through visualization 41 

and quantitative analysis of the movement of tokens through the pathway using network analysis tool 42 

BioLayout Express3D, 4) optimisation of model parameterisation and experimentation. This is the first 43 

modelling approach that combines a sophisticated notation scheme for depicting biological events at the 44 

molecular level, with a Petri net-based flow simulation algorithm and powerful visualisation engine with 45 

which to observe the dynamics of the system being modelled. Unlike many mathematical approaches to 46 

modelling pathways, it does not require the construction of a series of equations or rate constants for 47 

model parametrisation. Depending on a model’s complexity and the availability of information, its 48 

construction can take days to months, and, with refinement, possibly years. However, once assembled 49 

and parameterised, a simulation run, even on a large model, typically takes only seconds. Models 50 
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constructed using this approach provide a means of knowledge management, information exchange, and 51 

through the computation simulation of their dynamic activity, a means to generate and test hypotheses, 52 

and predict a system’s behaviour when perturbed.  53 

Introduction 54 

The era of molecular biology has resulted in the generation of vast amounts of data on biological 55 

processes, ranging from in-depth studies of one or two molecules and their interactions, to large sets of 56 

omics data. These data are currently scattered in the literature and databases and difficult to connect 57 

together. Those trying to learn about a particular biological process or pathway often start by studying the 58 

primary literature and reviews. However, relying only on the medium of the written word it can often be a 59 

struggle to understand the available knowledge as a series of interconnected events. The task is made 60 

more difficult as the literature often refers to the same pathway component by different names, which may 61 

not or not be their official names (as dictated by nomenclature committees). Representation of biological 62 

systems as graphical models, i.e. diagrams, can in principle circumvent these issues by presenting a 63 

system in a visually intuitive manner using a standardized notation scheme to represent pathway 64 

components and the interactions between them. One of the ultimate goals of a pathway model is the 65 

ability to use it for computational simulations, thereby supporting hypothesis generation and experimental 66 

design. Use of a system that fulfils these criteria could benefit any scientist working in experimental 67 

biology.  68 

 69 

We have developed a modelling platform that combines elements of other approaches1. The modified 70 

Edinburgh Pathway Notation (mEPN) scheme was first published in 20082, refined in 20103, and is 71 

presented here in its current form (BOX 1).  Representing the interactions between biological components 72 

in the context of a pathway diagram is a challenge, and a number of notation schemes have been 73 

proposed3-9. In an effort to standardise pathway diagrams, the Systems Biology Graphical Notation 74 

(SBGN) community proposed standards for pathway depiction, including the process description (PD) 75 

language7 based on ideas first proposed by Kitano et al.4. In SBGN-PD diagrams (and in the modelling 76 

approach described here), components of a pathway are depicted using a standard set of shapes 77 
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(glyphs), and both the nature of the interactions between components and the products of those 78 

interactions must be shown explicitly. Pathway models are constructed where entity nodes represent 79 

molecular components, process nodes represent the different types of interactions that can occur 80 

between the components, and edges link entity and process nodes. Since PDs were first described 81 

various models have been constructed based on this approach2,10-15 and there is a growing number of 82 

software tools that support model creation (using SBGN-compliant languages), e.g., CellDesigner16,17, 83 

NaviCell11, KEGG Mapper18, ReactomeFiViz19, iPath20 and SBGN-Ed21. There are also a number of 84 

centralised databases providing pathway resources of this type22-25. The mEPN scheme used here to 85 

model pathway systems is similar to the SBGN ‘process description language’ but with important 86 

differences in how both components and events are represented. In particular, mEPN supports the 87 

representation of wider variety of biological components and processes, simplifies the depiction of 88 

complexes, promotes the use of standard nomenclature, and importantly, diagrams can be used directly 89 

for the computational modelling of system dynamics (for a more complete description of mEPN and 90 

comparison to the SBGN-PD language, see O’Hara 20161). mEPN pathway models can be drawn using 91 

the free graph editing software yEd (yWorks, Tübingen, Germany; www.yworks.com), and since the 92 

notation scheme was first described 2,3 has been formalised so as to support the use of models for 93 

pathway activity simulations1.  94 

Numerous mathematical approaches exist to simulate system dynamics including ordinary and partial 95 

differential equations, qualitative differential equations and stochastic equations. The Systems Biology 96 

Markup Language (SBML) has been developed as an open interchange format for such mathematical 97 

models26 and the SBML site also has an extensive list of existing tools and resources supporting pathway 98 

modelling primarily by equation-based approaches 99 

(http://sbml.org/SBML_Software_Guide/SBML_Software_Summary). Most mathematical models require 100 

experimentally derived rate constants to feed into equations and significant computational power to solve 101 

a series of equations. This generally limits equation-based approaches to modelling relatively small and 102 

well characterised systems. Moreover, the level of mathematics skills required to construct and run these 103 

models is often a deterrent to adoption by biologists. The platform described here uses Petri nets, as the 104 

basis for pathway activity simulations. The primary resource for Petri net modelling is a network diagram 105 
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consisting of nodes, called ‘places’, and other nodes representing the interactions between them, called 106 

‘transitions’, to which the user need only add ‘tokens’, that represent the amount or activity of a place prior 107 

to performing a simulation (for more details of Petri nets see BOX 2). There is a long and established 108 

precedent for the use of Petri nets in the modelling of biological pathways 27-33 and several tools and 109 

algorithms are available that allow the user to construct models based on Petri nets 34-36. The Petri net 110 

algorithm employed here was first described by Ruths et al.37 who named their approach the signalling 111 

Petri net simulator (SPN). It combines elements of a Boolean network simulator38 with a synchronized 112 

Petri net model39, and models the stochastic flow of tokens through a network. A great advantage of Petri 113 

nets is the relative ease of model parameterisation, the scale to which models can be constructed, the 114 

computational speed of simulations, as well as the fact that the user does not need to directly modify the 115 

maths when experimenting. The downside to most of the tools that currently support pathway modelling 116 

using Petri nets is the inability to represent pathway models in anything but the standard Petri net notation 117 

(open circles and black rectangles), and limited options for the visualization of results. Here, we describe 118 

how a pathway model drawn according to the rules of mEPN, can then be parameterised for 119 

computational modelling by the addition of tokens, whose quantity can be based on experimental results 120 

such as quantitative transcriptomics or proteomics data. When a mEPN model is imported into the open-121 

source software BioLayout Express3D 40 it is visualised in a 3D environment, with nodes now represented 122 

as 3D shapes. Simulations can subsequently be performed that calculate the flow of tokens through the 123 

pathway over time. Pathway activity can then be visualised as plots or animations, where token 124 

accumulation is represented by the size and colour of an entity node (Supplementary Video 1). Altering 125 

the simulation parameters can change the flow of tokens, allowing the dynamics of pathways to be 126 

modelled under different conditions. The modelling approach described in this protocol can be applied to 127 

model any system, large or small, biological or otherwise, that consists of a series of components that 128 

interact in a predefined manner. In the case of biological pathways, the mEPN notation scheme allows for 129 

the detailed representation of signalling cascades, metabolic pathways, transcriptional networks, as well 130 

as feedback/feedforward loops. To date, we have used this approach to model a wide variety of biological 131 

pathways, particularly associated with immune signalling, e.g., Toll-like receptors (TLR), NF-kB, 132 

complement activation and antigen presentation, but also biochemical pathways e.g. cholesterol 133 
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metabolism, TCA cycle, and even pathways spanning multiple organ systems e.g. glucocorticoid, 134 

oxytocin/prolactin signalling (see: www.virtuallyimmune.org and O’Hara et al.1 for examples). Many of 135 

these models were built as graphical representations of events as described in the literature and as such 136 

act as a graphical bibliography, with pathway components or processes hyperlinked to research papers or 137 

reports. However, with additional work they can also be used as the basis for performing simulation 138 

experiments. These simulations not only test the logic of what is depicted, but also predict the behaviour 139 

of the system and its response to perturbation. Using this approach models can be assembled at scale, 140 

representing tens or thousands of components and the interactions between them. The overall aim of the 141 

modelling approach described here is to, provide a platform for the assembly of information on a 142 

particular system into an informative diagram, to allow the use of the diagram explore how the system 143 

might operate, and through experimentation, make testable predictions 41 42. 144 

The protocol provided here complements the paper published recently by O’Hara et al.1, which describes 145 

the development of and underlying concepts associated with this approach. This modelling platform may 146 

not be appropriate in situations where many of the interactions between components are not known due 147 

to the requirement to define both components and interactions, or where there is need to use specific rate 148 

parameters to regulate the dynamics of a system, as the approach does not allow for the integration of 149 

rate constants for specific reactions. Other limitations of Petri net-based approaches are the requirement 150 

that all tokens and transitions behave the same way. In other words how a protein binding event is 151 

modelled, is the same as how an enzymatically catalysed biochemical reaction would be modelled, where 152 

outputs are determined by the number of tokens on the reactants. This is not likely to be an issue for 153 

many applications, but could limit the approach’s applicability in certain circumstances requiring a more 154 

complicated concepts to be built within the model. 155 

 156 

Experiment Design 157 

First we describe how to construct a graphical model of a biological pathway using the mEPN scheme 158 

(steps 1-8). We then explain how to convert this purely graphical representation into a resource that 159 
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supports computational modelling of the system (steps 9-11). Next, we present how to test the dynamic 160 

properties of the model through running simulations and visualizing results (steps 12-20), and in the final 161 

section (steps 21-25), describe how to optimise and validate the pathway model. The workflow is shown 162 

schematically in Figure 1. To illustrate our approach, we use a model of interferon-β signalling. The model 163 

is small and simple, but encompasses many of the basic concepts associated with pathway construction 164 

and motifs such as a negative feedback loop, a common feature of many biological systems 43. However, 165 

we encourage the examination of other larger models we have constructed, covering a range of biological 166 

systems, in order to appreciate the scale and complexity models can achieve (examples can be found at 167 

www.virtuallyimmune.com). Before embarking on model construction, users should search the literature 168 

and pathway databases, such as those listed in Table 1, for existing diagrams of their system of interest. 169 

Careful consideration should be given to the initial scope of the model, the level of detail to be 170 

represented and what the model is to be used for once constructed. For instance, given the 171 

interconnectivity of biological pathways, it is easy to begin with the aim of modelling one thing and end up 172 

spending a lot of time modelling something entirely different, because it is one way or another related to 173 

the first. Having said this, models will inevitably evolve as information is gathered and assimilated, and 174 

the journey taken is part of the reward of modelling. 175 

 176 

Materials  177 

Equipment  178 

A computer with Windows, Apple Mac or Linux operating system (preferably 64-bit), internet connection 179 

and a web browser with JavaScript enabled. The hardware configuration may limit the size of models that 180 

can be displayed within yEd, as well as when running pathway simulations within BioLayout Express3D, 181 

where it will influence the speed of simulations and the frame rate for animations of flow. We 182 

recommended >4Gb main RAM, a Dual-core CPU, NVidia GeForce / Quadro series or ATI equivalent 183 
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graphics card for advanced visualization with GLSL Shaders, preferably two monitors capable of 184 

displaying at 1,600 x 1,200 resolution and a three-button mouse to aid navigation.  185 

 186 

Equipment setup 187 

Installation of yEd Graph editor 188 

yEd is a free and intuitive software application that can be used to create high-quality network diagrams, it 189 

runs on all major platforms: Windows, Unix/Linux and Mac OS X. Download and install the latest release 190 

of the yEd Graph editor from the yWorks (Tübingen, Germany) website www.yworks.com. yEd will use up 191 

approximately 215 MB of hard disk space. If you encounter any problems with the installation of yEd 192 

contact: support@yworks.com  193 

Loading the mEPN palette 194 

Download the GraphML (.graphml) file containing the mEPN glyphs (Supplementary Data 1) and load it 195 

into yEd by selecting Edit → Manage Palette → Import Section. This will provide the standard palette of 196 

mEPN glyphs that can be selected as required when constructing a pathway model. To display the mEPN 197 

symbols palette select from the menu bar Windows → Palette. Alternatively, create each node type 198 

afresh by adding a node and changing its visual properties [F6]. As an example, see the list of 199 

components present in the interferon-β pathway (Figure 2A). 200 

Installation of BioLayout Express3D 201 

BioLayout Express3D software allows the visualization and analysis of large network graphs in two and 202 

three-dimensional space and supports the computational modelling of networks using the signalling Petri 203 

net (SPN) algorithm37. BioLayout Express3D runs on Windows, Mac OS X and Linux platforms. Java SE 6 204 

or 7 is required and can be downloaded from http://www.java.com/getjava. BioLayout will use up 205 

approximately 41 MB of hard disk space. To download the BioLayout Express3D installer, navigate to 206 

http://www.biolayout.org/download/ and download an installer for Windows (.exe) or Mac OS X (.dmg). 207 

For Linux platform use the universal JAR file that may be run without an installer. When BioLayout 208 
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Express3D runs for the first time it creates a preferences file that can be changed and saved at any time 209 

from the menu option Tools → Save Preferences. Users can customize many options selecting from the 210 

menu bar Tools → General Properties (Shift+P). Further details on the software interface and its 211 

customization are available in the BioLayout Express3D manual that can be downloaded from the tools 212 

support pages. If you encounter any problems with the installation of BioLayout Express3D contact: 213 

support@biolayout.org  214 

 215 

Procedure  216 

Pathway model construction (timing: hours to months depending on complexity 217 

of model)  218 

1. Source information for pathway construction. A pathway model should aim to provide a 219 

comprehensive and reliable view of the current state of knowledge about the system. To 220 

achieve this collect and extract the relevant information about the pathway from the literature, 221 

databases and existing diagrams. Possible sources to consult are presented in Table 1. A 222 

comprehensive list of databases for data mining can be found at www.pathguide.org. For 223 

some pathways, data are available from multiple species and/or cellular systems, therefore 224 

users must decide whether to piece together information from heterogeneous sources or to 225 

restrict their model to reflect a particular species, cell type or developmental stage. To keep 226 

track of the data, create a spreadsheet that includes: molecular identifiers, e.g. HUGO, 227 

Entrez IDs, details about nature of the molecular interactions, sources of information, e.g. 228 

PubMed ID, the quality of evidence (as assessed by number of publications supporting a 229 

given interaction and the reliability of the assays used) and any additional information that 230 

may be relevant.  231 

!Troubleshooting 232 

 233 

 234 
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2. Identify the types of pathway information. Divide details of the pathway of interest into the 235 

categories defined the mEPN notation scheme (see BOX 1). Find the ‘real’ name of pathway 236 

components. The use of standard gene/protein names is essential in defining the exact 237 

identity of components, especially if models are to be used in the interpretation of omics data 238 

where the use of standardised nomenclature systems is standard practice (see BOX 3). 239 

Record and characterise the type of interaction between components. 240 

 241 

3. Commence drawing - addition of entity nodes. Molecular components are represented using 242 

entity nodes. To add an entity node to the diagram, select and drag the appropriate glyph 243 

from the mEPN palette (BOX 1).  Edit a node’s properties by selecting it and pressing [F6]. 244 

The node Properties dialogue will appear. Add the component’s name to the General tab, 245 

where necessary changing the size of the node to fit the label, record the reference source or 246 

insert a brief description about a given component in the Data tab. Also add a hyperlink to an 247 

external site (for example NCBI’s Gene database), which can then be activated by selecting 248 

the node and pressing [F8]. A description of the component, if available, will be shown in a 249 

pop-up window when the mouse is placed over the node in yEd.  250 

 251 

4. Draw the interactions between entity nodes. The nature of an interaction between 252 

components may be represented using a combination of process nodes and edges. To add a 253 

process node to the diagram, select and drag the appropriate glyph from the mEPN palette 254 

(BOX 1). As with components (entity nodes) additional information may be added to the 255 

process node by selecting it and opening the Properties dialogue [F6]. Pathway modules are 256 

a special type of process node. They represent multi-reaction processes or events and are 257 

represented using octagons with a label identifying the name of the process they represent. 258 

They might be used to represent such pathway as signalling cascades, endocytosis, 259 

compartment fusion, etc. Edges are lines that join entity and process nodes. Edges denote 260 

the type of interaction (activation, catalysis, inhibition) and their directionality establishes 261 

inputs and outputs from entity/process nodes. To add an edge, click on a node using left 262 
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mouse button and keep held down, then drag the mouse to move the edge to the target node 263 

and release. If you release the mouse button on the way to the target node, a pivot point will 264 

be introduced. To change the appearance of an edge (colour, thickness, arrow type or to add 265 

text/hyperlink), select the edge by clicking on it and open the edge properties dialogue [F6]. 266 

The sample Interferon_components.graphml file can be used to try out the procedures 267 

described in this step (Supplementary Data 2). Note: yED supports the import of data in 268 

Excel or .CSV files in a variety of formats (see http://yed.yworks.com/support/ for details). 269 

This functionality may help initially in defining a set of pathway components and the 270 

interactions between them, prior to manual editing of node/edge properties and layout. 271 

CRITICAL STEP. In general (and absolutely so when constructing a diagram to be used for 272 

computational modelling), nodes comprising a pathway should be arranged as a bipartite 273 

graph i.e. entity nodes should be connected exclusively to a process nodes and vice versa. 274 

This structure is the same structure used by Petri nets (places must be connected to 275 

transitions) and it is essential if the model is to be used for simulation experiments. 276 

 277 

5. Add compartments. Components should be represented as existing within a given cellular 278 

compartment. Drag the desired compartment node from the mEPN palette and enlarge it to 279 

cover the section of the pathway diagram which represents a given cellular compartment 280 

such as the plasma membrane, cytoplasm or nucleus. Move the selected compartment 281 

behind the diagram by choosing Edit → Lower selection. Name the compartment, placing the 282 

name between asterisks (*compartment name*). The asterisks inform the BioLayout 283 

Express3D parser to treat these nodes differently: they are displayed as a translucent 284 

background to the pathway and cannot be selected within this tool. If they are labelled as 285 

follows *compartment*N* where *N* is a numerical value, e.g. 100, when viewed in BioLayout 286 

the compartment becomes a 3D container where the N value determines its depth (Z-value). 287 

The decision on a compartment’s ‘depth’ is based on purely on final aesthetics as 288 

compartments do not effect model dynamics.  Generally the cell membrane would be the 289 
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largest component and its internal organelles are smaller compartments that sit within it, but 290 

other than this the values given are subjective. Suggested cellular compartment colours are 291 

defined in the mEPN palette. Generally, when compiling a model it is best to add 292 

compartment nodes at the end or at least put them to one side when editing, as they tend to 293 

get in the way. The completed pathway should look similar to the interferon-β pathway 294 

example in Figure 2B. 295 

 296 

6. (Optional) Add negative feedback loops. Feedback loops are network motifs common to 297 

many systems and involve the activation of a pathway component that goes on to inhibit an 298 

earlier step in the process. The inhibition of the interferon-β receptor by SOCS1 whose 299 

transcription is activated by the interferon signalling pathway represents such a negative 300 

feedback loop (Figure 2B). To represent an inhibitory activity such as this using the mEPN 301 

scheme, place an inhibitor edge from the inhibitor molecule to a process node representing 302 

the step that is inhibited.  303 

 304 
7. Optimise model layout. It is essential that a pathway model is compact and easy to follow i.e. 305 

be readable by a human. How this is best achieved will be influenced by a model’s size and 306 

complexity. First organise the pathway components based on where they reside within the 307 

cell, i.e. their cellular compartment. Then attempt to separate out ‘modules’ based on 308 

connectivity amongst a group of nodes, e.g. a particular signalling cascade or other series of 309 

events. This helps with a model’s readability and facilitates model expansion as new data 310 

becomes available. Further information on layout optimisation can be found in BOX 4. In 311 

practice, model optimisation is normally an iterative and time consuming process often 312 

requiring a degree of trial and error in how best to layout the diagram. When in the dynamic 313 

modelling phase it may for example be necessary to add in motifs that in effect delay the 314 

passage of tokens from place to another in order, to model processes that are not explicitly 315 

shown but may influence the order or timing of an event. 316 

 317 
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8. Save and export the pathway models. The pathway model should now represent a 318 

diagrammatic version of known events and should be saved in the GraphML file format 319 

choosing File → Save. Within yEd a model can also be exported as an image in PNG or JPG 320 

format, as PDF or as HTML by selecting File → Export and selecting the preferred format.  321 

 322 

Model testing - conversion of a graphical model into a computation model 323 

(timing: minutes to hours) 324 

9. Set the initial parameters. To convert a graphical representation of a pathway into a 325 

computational model, you must define the initial state of the system through a process of 326 

‘parameterisation’. To parametrise the assembled model, add defined numbers of tokens to 327 

entity nodes at the beginning of network i.e. nodes that have no ‘parents’ (upstream 328 

connections). To define the initial state of a component, place an input node (depicted as a 329 

black rectangle which functions as a transition node) upstream of the component to be 330 

parameterised and connect it with a standard edge. Define the number of tokens to be added 331 

to the node by selecting the edge between an input node and component. Open the edge 332 

properties dialogue [F6] and type the desired number of tokens into the edge name (text) 333 

(Figure 2C). Token values can in theory range from 0 to millions but in essence represent the 334 

relative amount or activity of a given component under initial conditions. Ideally, the initial 335 

parameters should be set with reference to some experimental data providing information on 336 

the relative initial concentrations of the pathway components where known. However, in the 337 

initial stages of pathway parameterisation and model testing, it is often sufficient to place an 338 

arbitrary number of tokens on components, e.g. 1000, just to check the connectivity between 339 

inputs and outputs is not compromised in any way.  340 

 341 

10. Defining inhibitory reactions. An inhibitor edge originates from an inhibitory molecule and 342 

terminates at the process to be inhibited, tokens present on the inhibitor node preventing 343 

token flow through the process node. During a simulation tokens will not be lost through an 344 
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inhibitor edge and therefore tokens accumulate on an inhibitor node and irrevocably block the 345 

process to which it is connected. However, if a sink node is connected to the inhibitor it 346 

serves to give the inhibitory molecule a ‘half-life’ (in practice any process node will serve the 347 

same purpose, but use of the sink node helps visually define the process involved). In the 348 

absence of further input into the inhibitor node, such as during the ‘off phase’ of negative 349 

feedback system, tokens will now be lost from the inhibitor. The result is that its inhibitory 350 

effect will lessen and the blocked transition will eventually open and tokens may flow again 351 

through it. In presence of a constant input this can cause token flow in negative feedback 352 

systems to oscillate. There are two types of inhibitor edge included in the notation scheme 353 

that perform differently in the modelling environment; the non-competitive inhibitor edge (red 354 

with perpendicular bar at end) and a competitive inhibition edge (red with open diamond end). 355 

The non-competitive inhibitor edge completely blocks token flow through the target 356 

transmission if any tokens are present on the inhibitor node. In contrast the competitive 357 

inhibitor edge works by deducting the number of tokens residing on the inhibitor away from 358 

the number of tokens flowing through the target transition. The behaviour of negative 359 

feedback systems is not only dependent on the type of inhibitor edge used but also the 360 

distance between the input of tokens and the inhibitory step. The greater the distance the 361 

more tokens are able to accumulate in the system and the greater the time taken between 362 

the opening and closing of the inhibited transition, i.e., the longer the wavelength and the 363 

higher the amplitude of the oscillating signal. Other factors that can affect the oscillatory 364 

behaviour of the feedback loop are the number of inhibitors acting on the pathway and 365 

assumptions about the stochasticity of token flow. 366 

 367 

11. Save the parameterised model in the GraphML file format choosing File → Save. GraphML 368 

files can be loaded directly into BioLayout Express3D. A parser within the tool translates the 369 

mEPN nodes into their 3D equivalent shapes such that they can now be visualised within the 370 

tool’s 3D environment. It also differentiates between nodes in the diagram that act as Petri 371 

net ‘places’ and that are ‘transitions’, and reads the parameterisation markings that define 372 
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initial token inputs. BioLayout Express3D is also able to perform stochastic flow simulations 373 

using a modified version of the signalling Petri net algorithm37. A file containing simple Petri 374 

net models of all primary motifs found in pathways is provided as a means to better 375 

understand the flow characteristics of this algorithm (Supplementary Data 3). 376 

 377 

Running simulations using BioLayout Express3D (timing: 5-15 min) 378 

12. Load the saved GraphML file into BioLayout Express3D. Supplementary file 4 is the 379 

interferon-β pathway model shown in Figure 3C and as such is ‘simulation ready’. 380 

Following opening of the file answer yes to the dialogue window “This looks like a 381 

Signalling Petri Net (SPN) pathway. Would you like to run a SPN simulation now?” (Figure 382 

3A). This opens the SPN simulation dialogue (Figure 3B). The dialogue can also be 383 

selected from the main menu under the Simulation menu or by pressing the “RUN SPN” 384 

button on the sidebar. 385 

!Troubleshooting 386 

 387 

13. Set the SPN simulation options. Choose the number of time blocks and the number of runs. 388 

A ‘time block’ is when all transitions are fired exactly once in a random order and tokens 389 

moved as a result. A series of time blocks is referred to as a ‘run’, the more time blocks the 390 

longer the run (Figure 3B1). The bigger the model or the more conditions you want to test 391 

within a simulation, the more time blocks you will require for a simulation. It is good practice 392 

to check the nodes furthest away from token input points to ensure that token accumulation 393 

has plateaued or in the case of negative feedback circuits, that enough time blocks have 394 

been run to evaluate the oscillatory behaviour of the system. The Petri net algorithm 395 

employed here is stochastic in nature. That is to say that the number of tokens passed on, 396 

when a transition is ‘fired’ is variable depending on the algorithms stochastic setting (see 397 

below), and furthermore the order in which transitions are fired is random. Therefore, the 398 

result of individual runs can be highly variable. For this reason a simulation is generally 399 
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comprised of multiple runs, where the outcomes from individual runs are averaged to 400 

calculate the mean number of tokens present on a given node at each time block (Figure 401 

3B2). The more runs used the less variable the results between simulations, but the more 402 

time it will take to perform a simulation. To visualise the variation associated with a given 403 

simulation check the ‘Calculate Variance’ and pick either standard deviation or standard 404 

error (Figure 3B3).  405 

 406 

14. Select the token stochasticity setting. The possible modes for token flow can be selected as 407 

shown in (Figure 3B4) and are described below:  408 

 409 
Uniform Distribution: Each time a transition is fired, an entirely random number of 410 

tokens between zero and the maximum number of tokens are moved from an input place 411 

to the output place (assuming there no other inputs on the transition which may influence 412 

flow). This mode is as originally described by Ruths et al.37 in their description of the 413 

SPN algorithm. 414 

Standard Normal: Each time a transition is fired, the number of tokens moved between 415 

input and end places will be randomly chosen from a standard normal distribution around 416 

50% of the number of tokens on the input place. 417 

Deterministic: This moves exactly half of the tokens from input place to the output place 418 

each time a transition is fired. 419 

 420 
Normally we would use the standard normal distribution setting, as a halfway house between 421 

the other two modes of token flow. In some settings, the average result of simulations is 422 

similar with all these settings although variation between runs is greater with the more 423 

stochastic token flow settings, especially the uniform mode. However, when simulating 424 

feedback loops the mode of token flow can have a marked effect on the behaviour of such 425 

systems.  The mode you select may be based on which best models your system of interest.  426 

 427 
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15. Selection of SPN simulation transition type. Token movement between places is via transition 428 

nodes which all operate using the same set of rules governing token flow. We have introduced 429 

two options, consumptive transitions and original transitions, which differ in how they operate 430 

with respect to token accumulation (Figure 3B5). Generally, we use the consumptive transition 431 

mode as this prevents the accumulation of tokens on entities where there is a constant input of 432 

tokens throughout the simulation but where flow through the target transition may be 433 

intermittent. 434 

 435 

Consumptive Transitions: Tokens are consumed from place nodes irrespective of 436 

whether the transition is ‘open’ or not i.e. if there are two inputs into a transition and one 437 

has tokens and the other does not, tokens will still be lost from the input place with tokens 438 

as if flow were unrestricted. 439 

Original Transitions: Tokens accumulate on input nodes where flow from them is 440 

blocked i.e. if there are two inputs into a transition and one has tokens and the other does 441 

not, tokens will not be lost from the input with tokens. This mode was as originally 442 

described by Ruths et al.37. 443 

 444 

15. Run the simulation. Press the ‘Run the Simulation’ button to initiate the computation of the SPN 445 

algorithm (Figure 3B6).  446 

Critical Step. The time it takes to run a computation depends on the number of time 447 

blocks/runs, the size of the pathway model and hardware on which the simulation is run. 448 

However, for most small to medium size pathways (10’s-100’s of entity/process nodes) and 449 

hardware configurations, the time taken is usually a few seconds or less for a typical modern 450 

laptop. 451 

!Troubleshooting 452 

 453 
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16. Save the results. Once the SPN simulation algorithm has finished, a Simulation Results 454 

dialogue appears (Figure 3C). Token level per node per time block results can be saved as a 455 

.txt or .spn file by ticking the “Save SPN Results” or pressing ALT+S (Figure 3C7). Saved 456 

simulation results files can be loaded pressing ALT+L in the main window. .spn result files can 457 

also be opened in programs such as Excel as a spreadsheet, or viewed and edited in a text 458 

editor. An mEPN model can also be exported as a Systems Biology Graphical Notation 459 

(SBGN)44 diagram via File -> Export -> SBGN file. This can be opened in any SBGN compliant 460 

software, e.g. VANTED with SBGN-ED add-on21.  461 

17. Visualize token flow as node output graphs. To visualize the simulation results for a selected 462 

entity/place node, close the SPN simulation results dialogue (Figure 3C8), position the cursor 463 

over the node of interest and a pop-up window will appear showing the token flow associated 464 

with that node (Figure 3D). To view and compare token flow in multiple nodes, select the 465 

nodes of interest by pressing Shift+left mouse button and dragging the select window over the 466 

nodes of interest or by pressing the Shift+ALT+left mouse button to select multiple nodes. The 467 

corresponding flow graphs can be viewed using the Class Viewer by pressing CTRL+C 468 

(Figure 3E) or the button with cog icon on left menu bar of the main window (Figure 3G).  469 

A range of options are available within BioLayout to adjust graph appearance. Shift+> or 470 

shift+< will increase or decrease node size, respectively; under the General tab you may turn 471 

on or off the visualisation of the compartments (yEd Graphml Container Rendering); and by 472 

pressing the ‘Render Plot to File button’ on the top of the Class viewer window the graph can 473 

be saved as .jpg or .png image file (Figure 3E9).  474 

18.  Visualize token flow as an animation. Open the Simulation Animation Control window (ALT 475 

+ A) when the simulation has finished (Figure 3F). Use options provided within BioLayout 476 

Express3D tool to control simulation visualization: 477 
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Node Animation (Figure 3F10). Choose which nodes are animated (all, selected or 478 

pathway components only), and the type of animated transition that takes place between 479 

the node value associated with one time block and the next (discrete, linear, polynomial). 480 

Timing (Figure 3F11). Define how many time blocks per second are displayed and 481 

therefore the speed of the animation. If necessary also define which time block the 482 

animation begins from. 483 

Size Transition (Figure 3F12). Set maximum size of nodes during the visualization of token 484 

flow, i.e. when the number of tokens is at its maximum. The ‘Set (fixed) node value’ is the 485 

number of tokens on a node at which the maximum node size/colour is reached. The default 486 

value for the ‘Max value’ is determined by the maximum number of tokens that accumulates 487 

on any node during a simulation. It is often the case that some nodes accumulate tokens 488 

much in excess of others, e.g. when their output is blocked. This can result in the majority of 489 

nodes seemingly to change little in size or colour during a simulation. Click on this value and 490 

add a value of your choice, and click on the associated check box, to maintain this value for 491 

subsequent runs. 492 

Colour Palette Spectrum Transition (Figure 3F13). A number of colour palettes are 493 

available, or one can be loaded by user, to colour nodes so as to reflect their token value. 494 

Select colour spectra from dropdown menu, load your own, or more normally, use default. 495 

 496 

19. Visualize token flow as an animation. Select ‘Start Animation’ (Figure 3F14) to watch tokens 497 

flow through your model (Figure 3G and Supplementary Video 1). 498 

!Troubleshooting 499 

 500 

Model optimisation, parameterisation and validation (timing: days to months) 501 
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20. Check for errors. Errors in a diagram’s structure (predominately a failure to adhere to the strict 502 

requirement for a bipartite graph or improper logic), can lead to bottlenecks in token flow. 503 

When the bipartite graph structure is not maintained (e.g. an entity node is directly linked to 504 

another), tokens will accumulate on the node upstream of the issue and tokens are not passed 505 

downstream of the error. Check the reactions preceding any entity node whose token output is 506 

zero (Figure 4A) and correct mistakes. Place and transition spacer nodes are available to 507 

position between two nodes of the same type where the graphical description of events leads 508 

to this situation. Another common issue encountered is where the presence a pathway 509 

component is under the control of the system in which it operates. This can lead to a situation 510 

whereby for component to be synthesised it needs the pathway to be active, but the pathway 511 

is not active because it requires the activity of that component. In these circumstances it may 512 

be necessary to ‘prime’ the system adding tokens to the component in question prior to 513 

beginning the simulation. Mistakes and errors in logic are easy to make, but equally easy to 514 

spot and rectify with this approach. It is normal practice to run a simulation, find out where the 515 

issues are, edit the model in yEd and rerun the simulation. There will likely be a need to repeat 516 

this process a number of times.  517 

 518 

21. End of the line. Without a downstream transition, a component at the end of a line of flow will 519 

simply accumulate tokens (Figure 4A). A final transition node is required to dissipate tokens 520 

from such entities. One option is to place a ‘pathway node’ at these points by dragging and 521 

dropping from the palette to allow indication of what happens next without showing it in detail. 522 

Alternatively, a ‘sink’ node can be placed as described above to signify that a component is 523 

removed from the system, e.g., the destruction of a protein by proteosomal degradation.  524 

 525 

23. Amplify or reduce token flow at specific sites. To simulate the amplification or reduction of a 526 

signal at specific sites in the network, add a numeric value to a transition-to-place edge. Select 527 
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the edge, press [F6] and write a number in the Text field of the edge Properties dialogue. 528 

When a transition fires, the number of tokens produced on the downstream entity will 529 

correspond to the number of input tokens multiplied by the weight of the output edge, e.g., an 530 

edge weight of 2 will result in a doubling in the number of input tokens, where as an edge 531 

weight of 0.5 will halve the number of tokens going forward. For example, one can amplify 532 

tokens as means to model the production of numerous protein molecules from a single 533 

transcript during protein translation (Figure 4C). 534 

 535 

24. Varying token input during a simulation. To simulate variation in the level of an input signal at 536 

different time blocks of a simulation, assign tokens to an input edge (as described in Step 9) 537 

using the following notation : a-b,c;d-e,f where ‘a-b’ defines the first and last time blocks that 538 

the number of tokens ‘c’ will be added to the model and ‘d-e’ are the first and last time blocks 539 

that you would like the number of tokens ‘f’ to be added to the model. For example: 0-5,0;6-540 

15,100,16-20,0 translates into, add no tokens between time blocks 1-5, 100 tokens  between 541 

time blocks 6-15, and then remove token input until the end of the run, time block 20. Any 542 

number of these statements may be added to an input. This allows modelling of a system 543 

before and after a stimulus, or when a stimulus is transient or delayed. 544 

 545 

25. Validate the model by comparing it to experimental data. Once a model has been constructed, 546 

checked for structural errors and parameterised according to known variables, the first 547 

question is whether the model recapitulates the known activity of the system. For example, 548 

check if genes are expressed as transcriptomics data suggests, or does the flow of metabolic 549 

pathways under different conditions reflect what is known? The simulation of pathway 550 

dynamics should recapitulate the known activity of the system. If not, the obvious conclusion is 551 

the model is wrong. This could be because it is poorly constructed or parameterised, in which 552 

case the model needs improving. More interestingly, it could reflect the fact that there is part of 553 
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the system that is as yet undiscovered. Once a model is working, i.e., it verifies the known 554 

characteristics of the pathway, it can be used to test known perturbations of the system e.g. 555 

the effect of knocking down/out a gene or inhibiting an enzyme. With confidence in a model’s 556 

characteristics it is then reasonable to use it to predict the effect of perturbing it, proving 557 

results that can be tested experimentally: one of the ultimate aims of dynamic modelling. 558 

 559 

  560 
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Troubleshooting 561 

Troubleshooting information can be found in Table 2 562 

 563 

Table 2: Troubleshooting table. 564 

Step Problem Possible reason Solution 
1 Information about a 

part of the pathway is 
unavailable. 

The experiments to 
elucidate the process 
have not been done. 

Use a ‘pathway 
module’ node to 
indicate that a process 
occurs but the details 
of which are undefined.

12 BioLayout Express3D 
fails to run.  

Incompatible hardware 
or software 
configuration. 

Contact 
support@biolayout.org. 
Improve hardware 
specification. 

15 ‘Error with Vertex 
weight!’ error popup is 
shown during 
simulation. 

Token input to node(s) 
is not readable by 
software. 

Check that token input 
is numerical (token 
input can be any 
positive number, 
including decimals) at 
all token input nodes.

19 Flow stops and 
downstream nodes do 
not accumulate tokens. 
 
 
 
 
 
Node accumulates 
tokens at linear rate.
  
 
 
Token flow occurs, but 
the size of nodes 
changes little. 

Bipartite graph 
structure has not been 
adhered to. 
 
 
 
 
 
Node has no output. 
 
 
 
 
The maximum token 
value is set too high. 

Identify bottleneck 
node by watching 
BioLayout flow 
animation. Return to 
yEd graph to edit 
model and rerun. 
 
 
Return to yEd graph to 
add sink node or other 
transition to node 
accumulating tokens. 
 
Open Animation 
Control window and 
lower value in ‘Set Max 
Value’ dialogue box.

 565 

  566 
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Timing  567 

Steps 1 to 8, Information mining and pathway construction: Hours to months 568 

Steps 9 to 11, Conversion of the graphical model into a computable format: Minutes to hours 569 

Steps 12 to 19, Visualization of pathway and running simulations using BioLayout Express3D: 5 to 15 570 

minutes 571 

Steps 20 to 25, Model optimisation and parameterisation: Days to months  572 

 573 

Anticipated Results 574 

This protocol describes the generation of pathway models using the mEPN language for graphically 575 

representing biological systems. Graphical models can be used both as a resource to store and display 576 

what is known about a pathway and can be considered an end point in their own right, that can be 577 

updated or extended as new information becomes available. In addition, they can be converted to a 578 

computational model by setting parameters to define the initial state of the pathway. Using the sample 579 

interferon-β components GraphML file (Supplementary Data 2) a pathway model can be produced that 580 

represents events from the binding of interferon-β to its receptor and the signalling pathway leading the 581 

activation of target genes. The resulting model can be parameterised by adding tokens to obtain a 582 

simulation-ready model (Supplementary Video 1). This is a relatively small diagram; we also provide a 583 

model of the hedgehog signalling pathway as an example of a larger model (Supplementary Data 6). 584 

This was produced as part of a 10 week elective course by an undergraduate student with no previous 585 

modelling experience, indicating our modelling scheme can easily be performed by biologists with no 586 

prior modelling knowledge. Other pathway models are available at: www.virtuallyimmune.com.   587 

The BioLayout Express3D software is fully compatible with the mEPN notation and can be used for 588 

pathway visualization and to perform stochastic flow simulations using a modified version of SPN 589 
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algorithm37. Running simulations provides insights into the dynamic behaviour of the system by 590 

enabling users to visualize the signal flow within the network. The signal flow is simulated by the 591 

accumulation of tokens at entity nodes (places) and can be visualized in 2D graphs (as seen in Figure 592 

4) or by 3D animation (as seen in Supplementary Video 1). The inflation and contraction of the entity 593 

nodes represents the accumulation and degradation of reactants in the pathway. In this way, complex 594 

biological processes with multiple components can be modelled. 595 

 596 

The interferon-β signalling network - a feedback control system 597 

Biological systems display a variety of dynamic behaviours ranging from stable steady states to 598 

oscillations. Oscillations in protein concentrations or gene expression levels are commonly associated 599 

with the presence of negative feedback loop(s) in the regulatory network45. Based on the analyses 600 

performed using this system many factors can affect the amplitude, frequency and stability of oscillations. 601 

For instance, the time-delay (path length) between token input and inhibitor, the type of inhibition edge 602 

used (competitive or non-competitive), the number of inhibitors present and their half-life, may all affect 603 

how a model containing a negative feedback loop will operate in practice. 604 

As an example, the simple model of the interferon-β signalling pathway is presented. Interferon-β is a 605 

cytokine released by immune cells in response to pathogens. It acts as an autocrine and paracrine 606 

signalling system that triggers the activation of host defence systems. In the provided model it operates 607 

as a damped oscillator46, where low-dose IFN stimulation yields oscillations of lesser amplitude that are 608 

damped faster than those induced at a high-dose (Figure 5). To reproduce these observations users can 609 

look at the different versions of IFN signalling feedback model provided in Supplementary Data 5 or 610 

modify the token input or topology of the Petri net examples provided in Supplementary Data 3. 611 

 612 

Contributions of the authors: A.L., L.O’H., M.E.P developed and wrote the protocol based on their 613 

experience in using the approach for modelling their own pathway systems of interest, T.A. developed a 614 

number of the features within BioLayout Express3D including SBGN export and refinement of the Petri net 615 
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algorithm, D.W. developed and has helped maintain the VirtuallyImmune.org website that is associated 616 

with this work, and L.B.S. helped with writing and editing the manuscript. T.C.F. has lead the 617 

development of the mEPN notation scheme and its use in modelling a variety of pathway systems; 618 

oversaw the implementation of model import into BioLayout Express3D; model visualisation within this tool, 619 

refactoring and refinement of the Petri net algorithm, and conceived of and assisted in writing the paper.  620 

 621 

Figure legends 622 

Figure 1. Workflow with steps described in the Procedure. 623 

Figure 2. Construction of a simple pathway model describing type-1 interferon signalling. (A) 624 

Components of the interferon-β signalling pathway drawn using mEPN notation (BOX 1). The information 625 

necessary to construct the interferon-β pathway has been highlighted in the pathway description: entity 626 

and transition nodes, edges and cellular compartments. (B) interferon-β pathway diagram assembled in 627 

yEd software using the pathway parts shown in A. (C) Parameterisation of interferon-β pathway by the 628 

addition of token inputs and a sink node output on SOCS1 inhibitor node (highlighted by red rectangles). 629 

Also shown is the edge properties dialogue in yEd where tokens can be added to an input edge. Model 630 

adapted from O’Hara et al., 2016 1. 631 

Figure 3. Visualization of token flow. (A) When a model is loaded into BioLayout Express3D it is 632 

displayed in a 3D environment using 3D equivalents to the 2D node glyphs as rendered in yEd. The 633 

software automatically recognizes a diagram as having been parameterised for computational modelling 634 

(based on the presence of process nodes as defined in the notation system) and prompts users to run a 635 

SPN simulation. (B) In the SPN Simulation dialogue users can set constraints on how to run the SPN 636 

simulation algorithm. (1) Defines the number of time blocks in a simulation; (2) Defines the number of 637 

runs in a simulation; (3) Calculates the variance in token flow between runs; (4) Defines the nature of the 638 

stochastic flow of tokens; (5) Defines the rules governing token flow through transitions; (6) Run the 639 

simulation. (C) SPN Simulation Results dialogue box summarises the simulation. (7) SPN results may be 640 

saved before the user chooses to (8) run the simulation again, close the dialogue box or proceed to 641 
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animate the simulation. (D) After a simulation has been run token accumulation at specific nodes can be 642 

visualised by placing the cursor over the node. (E) The flow of tokens across one or a number of selected 643 

nodes can be plotted using the Class Viewer showing plots of token flow over the time course of the 644 

experiment for selected nodes. The name and class of selected nodes is also displayed, and below are a 645 

range of options available for node selection and data export. (9) The token plot can be saved as a .png 646 

or .jpg image file. (F) Animation Control dialogue. (10) Options for the type of nodes to be animated and 647 

interpolation of flow between time bocks; (11) Speed of animation (time blocks per second); (12) Node 648 

size at maximum token number; (13) Colour palette selection to highlight change in token number; (14) 649 

Animation control: start, pause, step, stop. (G) BioLayout Express3D can produce animations of token flow 650 

through the model across time blocks. Node size will increase/decrease depending on the number of 651 

tokens passing through them and the colour of the node will also change according to a predefined 652 

spectrum of colours.  653 

Figure 4. Influencing token flow along a linear pathway. Figure shows the flow of tokens through a 654 

small linear pathway motif depicting a gene being transcribed into mRNA, which is then translated into the 655 

encoded protein. Addition of a sink node represents the protein’s degradation. (A)  Blocked flow. Top of 656 

the three illustrations all is as described above, and over the 20 time blocks of the simulation there is an 657 

initial rise in the level of the protein followed by a steady-state, as the number of tokens entering the entity 658 

node matches those leaving through the sink i.e. the rate of production of the protein matches the rate of 659 

its degradation (blue line). Failure to maintain bipartite graph structure (shown here by connecting two 660 

entity nodes for mRNA and protein without a process node between them) causes tokens to accumulate 661 

on the first entity node (mRNA) and not pass to the second (protein), which stays at zero tokens 662 

throughout the simulation (pink line). In the absence of a sink node, tokens to accumulate on the protein 663 

node (green line). (B) Modelling time. The diagrams show the effect of increasing the length of linear 664 

networks on the rate of token accumulation. Input tokens are introduced into each of the networks at the 665 

same time but the protein accumulates at different rates. The delay is proportional to the number of 666 

transition steps introduced in the network and such delay motifs may be added where a transition nodes 667 

represents a multistep process such as transcription or translation.  (C) Amplifying or depleting signal. 668 

The addition of a value to the edge leaving a transition can be used increase (pink line) or decrease 669 
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(green line) downstream token flow. In this way one might model one mRNA molecule leading to 670 

production of multiple protein molecules, or the inefficient translation of mRNA where only a single protein 671 

molecule is produced from multiple mRNAs. Simulation options in A, B and C: 100 tokens, 100 runs, 20 672 

time blocks, Normal Standard distribution and with standard deviation of token flow between runs shown. 673 

Figure 5: Effect of parameterisation on activity of feedback loop. (A) A simple pathway model 674 

representing the type-1 interferon signalling pathway constructed and parameterized in yED using mEPN. 675 

Graphs show token accumulation on the activated transcription complex ISGF3 (circled in red) following 676 

simulations with (B) 1000 input tokens (blue line) or 100 input tokens (green line) added to interferon-β 677 

with SOCS1 acting as a non-competitive inhibitor or (C) as a competitive inhibitor of the activated receptor 678 

(dashed red edges). (D) Oscillatory activity of the SOCS1 feedback loop with (magenta line) or without 679 

(blue line) a delay introduced between the transcription and translation of SOCS1 (dashed black edges), 680 

again with SOCS1 acting as a non-competitive or (E) competitive inhibitor of the activated receptor. 681 

Simulation options: 100 runs, 500 time blocks, Normal Standard distribution and with standard deviation 682 

of token flow between runs shown. 683 

 684 

  685 
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Supplementary Files 686 

Supplementary Data 1.  mEPN palette for loading within yEd software. This is a graphml file containing 687 

all the different types of entity nodes to represent the different classes of molecules that might play a part 688 

in a pathway, as well as the process nodes that represent different types of interactions. This file can be 689 

loaded into yEd to provide a palette of mEPN nodes for pathway construction (see step 4 of the 690 

procedure). 691 

Supplementary Data 2.  Interferon-β signalling pathway components. This is a graphml file containing all 692 

the different parts of the simple model shown in figure 2B, to allow practicing model construction. Try 693 

assembling the model using only the text below: ‘Interferon B (IFNB1) is a cytokine released from many 694 

cell types in response to immune stimulation. It homodimerises and binds to its cell surface receptor 695 

complex composed of the receptor proteins IFNAR1 and IFNAR2 and the intracellular kinases TYK2 and 696 

JAK1.  The complex is composed of 2 of each of these proteins. Binding causes a conformation change 697 

in the complex resulting in the autophosphorylation of JAK1. Once activated, the complex catalyses the 698 

phosphorylation of STAT2 which forms a heterodimer with STAT1. This complex then binds interferon 699 

regulatory factor 9 (IRF9), forming the complex often referred to as ISGF3, and translocates to the 700 

nucleus.  Here it binds to the IRF sequence in the promotor of a number of genes including MX1, MX2, 701 

IFIT1, IFITM3, TAP1, OAS1, GBP1, PSMB9, SOCS1. In turn SOCS1 inhibits the autophosphorylation of 702 

the receptor thereby inhibiting further activation.’  703 

Supplementary Data 3.  Primary network motifs drawn in Petri net style for testing SPN algorithm. This is 704 

a graphml file containing a series of different network motifs and parameterisations potentially found in 705 

pathway diagrams. This includes linear networks, multiple inputs/outputs to transitions and nodes, and a 706 

series of models representing a range of feedback loops with varying path lengths between token input 707 

and inhibition, inhibition type (competitive vs. non-competitive), and one or multiple feedback inhibitors. 708 

The file is designed to allow you to explore the different interaction types and algorithm settings when 709 

setting up a simulation run. Certain nodes are coloured such that when a simulation has been run within 710 

BioLayout, these nodes may be selected and you can compare results across motifs. 711 



30 
 

Supplementary Data 4.  Interferon-β signalling pathway. This is a graphml file of the simple model 712 

shown in figure 2B.   713 

Supplementary Data 5.  Changing parameters - Interferon-β signalling pathway. This is a graphml file 714 

containing six versions of the model shown figure 2B (Supplementary Data 4), each version is 715 

parameterised slightly differently, with variation in: type of inhibition (competitive vs. non-competitive); 716 

introduction of a delay between SOCs1 expression and protein; and an amplification of signal between 717 

gene and mRNA.   718 

Supplementary Data 6.  Example of a more complex model - Hedgehog signalling pathway. This model 719 

(given here as graphml file) is a representation of Hedgehog signalling from the binding at its receptor, 720 

activation of the GLI protein on the tip of the primary cilium through the activation of various downstream 721 

pathways (not shown in detail). It contains 550 nodes and 601 edges and was assembled using pathway 722 

resources such as Reactome22 and the primary literature. Its parameterisation, in terms of token 723 

placement is arbitrary.  724 

 725 

Supplementary Video 1. Movie of the interferon-β signalling pathway (Supplementary Data 4) simulation 726 

run within BioLayout. The movie shows the process of model loading, running the simulation, inspecting 727 

token accumulation on specific components and watching the flow of tokens run through the model as an 728 

animation. 729 

 730 

 731 

 732 

 733 

  734 
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BOX 1: mEPN Notation 2017 735 

The modified Edinburgh Pathway Notation (mEPN) scheme3 is a graphical notation system based on the 736 

concepts of the process diagram4, below the glyph library is shown in its current form (reproduced from 737 

O’Hara et al. 1). 738 

 739 

 740 

Pathway components 741 

Types of pathway information. The information depicted in a pathway diagram drawn using the mEPN 742 

scheme may be divided into the following categories: 743 
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• Entity: any component involved in a pathway, e.g. protein, protein complex, nucleic acid 744 

sequence (promoter, gene, RNA), simple biochemical, drug etc., and depicted as an ‘entity node’. 745 

Different shaped nodes are used to represent different types of components. The mEPN scheme 746 

consists of twelve different entity nodes (detailed in the top left panel). Also included are a 747 

Boolean logic ‘OR’ operator node and spacer node (represented as a white circle with a black 748 

border) that may be required to maintain bipartite pathway arrangement. Entity nodes function as 749 

the equivalent of Petri net ‘places’ and all entity nodes are equivalent in Petri net simulations 750 

• Process: an interaction that occurs between pathway components, where one component 751 

interacts with or influences the state of another through its binding, inhibition, catalytic conversion, 752 

etc., is depicted as a process node. Processes are generally depicted as a circular node with a 1-753 

3 letter code to indicate the type of process, e.g., P = phosphorylation, B = binds, X =cleavage 754 

etc. Included in the scheme are 38 different process nodes (top central panel). Additional to 755 

these, but also acting as transitions, are a sink node which is placed at the end of pathway and 756 

represents removal of a component from the system; a pathway module node that summarises 757 

not one process but a series of events; a Boolean logic ‘AND’ operator node; token input nodes 758 

that are placed at the start of a pathway and oriented either horizontally or vertically to fit in with 759 

the pathway layout; a spacer node represented as a black diamond. A larger version of this node 760 

can also be used as a distribution node when multiple edges exit from an entity node. Process 761 

nodes function as the equivalent of Petri net ‘transitions’ and all process nodes are equivalent in 762 

Petri net simulations. 763 

• Interaction: a directional edge that links an entity node to a process node or vice versa that 764 

indicates direction and the nature of the interaction. There are six possible connecting edges 765 

(bottom central panel) that represent the nature of the interaction between nodes. The first three 766 

(interaction, catalysis and action potential) operate identically within a Petri net and serve to carry 767 

tokens between entity and process nodes. The two inhibitor edges act to inhibit the flow of tokens 768 

through target process nodes albeit based upon different rules. The non-competitive inhibitor 769 

edge completely blocks token flow through the target transmission if any tokens are present on 770 

the inhibitor node. In contrast the competitive inhibitor edge works by deducting the number of 771 
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tokens residing on the inhibitor away from the number of tokens flowing through the target 772 

transition. Finally, the non-covalent interaction edge can be used to depict two separate entities 773 

within a complex. This may be a useful when describing large complexes, but these edges do not 774 

operate within the context of a Petri net simulation.  775 

• Cellular compartment: define where pathway components reside and interactions take place, 776 

such as an organelle (e.g. mitochondrion, nucleus) or a transient cellular compartment (e.g. 777 

vesicle). In the diagrams they are shown as large coloured nodes that sit behind the interaction 778 

model (right panel). 779 

End of Box 1 780 

 781 

  782 
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BOX 2: Petri nets to model biological systems 783 

Petri nets (panel A) are a mathematical approach for describing distributed systems and have been used 784 

extensively in the modelling of many different kinds of systems including biological pathways. There are 785 

numerous types of Petri net algorithms and software that support modelling using them. The Petri net 786 

algorithm employed here was first developed and described by Ruths el al.37, a modification of a 787 

synchronized Petri net model and firing policy, they called the signalling Petri net (SPN). Petri nets share 788 

a number of common features. Models are constructed as directional bipartite networks where nodes are 789 

considered to be either ‘places’ or ‘transitions’ connected by ‘arcs’. Places usually represent an entity or 790 

state and by convention are represented as a white circle. Transitions represent interactions between 791 

entities or the transition of an entity from one state to another and are usually represented as a black 792 

rectangle. Arcs are directional arrows that connect places to transitions and vice versa. The availability of 793 

an entity and its abundance can be represented by the initial placement of tokens. The flow of information 794 

through the network is represented using tokens that move between places through transitions, following 795 

in the direction of the arcs. In the context of biological pathways paces represent pathway components, 796 

transitions correspond to processes that modify the components in some way, such as phosphorylation, 797 

binding etc., and are referred to as ‘process nodes’. The interactions between molecules are depicted by 798 

edges, equivalent to arcs in Petri net parlance. Panel B shows how the notation for representing 799 

pathways using mEPN map on to Petri nets. 800 
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 801 

Rules determining token flow through transitions. Activity flow is represented by the movement of 802 

tokens between places. The state of each place (component) is determined by the number of tokens held 803 

by it. When a transition is fired, tokens are moved from each input place and redistributed downstream, 804 

the transition acting as rule-based controller of flow. A transition will pass on tokens only if all the input 805 

places contain tokens and where one input has less tokens than others, the passage of tokens will be 806 

governed by the input place holding the least number of tokens. In the case of the Petri net algorithm 807 

employed here, the movement of tokens is also stochastic.  This is because during a time block all 808 

transitions in a model are fired once but in a random order, and the number of tokens taken forward when 809 

a transition is fired will be a random number between zero and the maximum available (although we have 810 

implemented other versions of this rule, see step 13). Due to the stochastic nature of token flow, a 811 

simulation usually comprises of a number of runs, the answer being based on the average token flow 812 

across runs. Furthermore, when a transition is fired the number of tokens moved forward through the 813 

transition will be subtracted from the amount available on the input places. One innovation not found in 814 

most other Petri net simulators, is our implementation of a consumptive transition mode. When running in 815 

this mode (for us this is standard), a constant input of tokens is applied to an entity node throughout a 816 

simulation, but token levels on the node remain constant (unless others are fed in from another source), 817 
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as tokens are lost from it at the same rate they are added even when there is no flow through the target 818 

transition. In this way places representing entities such as enzymes (or indeed any other molecule) can 819 

receive a constant input of tokens throughout a simulation without accumulating or losing tokens.  820 

Modelling time. Time in Petri nets is measured in abstract units called time blocks. When constructing a 821 

model, it is useful to consider how many experimental seconds, minutes, or hours correspond to a time 822 

block. Timing depends on the network topology and the further away a node is from the start of flow the 823 

longer it will take tokens to reach it. To simulate such time delays users can create a linear network that 824 

alternates transitions with spacer nodes multiple times. When tokens are passed through such a linear 825 

network the number of output tokens corresponds to the input but the time taken for tokens to reach the 826 

end is proportional to the number of spacer nodes (Figure 4B). 827 

 End of Box 2 828 

 829 

 830 

 831 

  832 
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BOX 3: Component Annotation 833 

Multiple names are frequently employed to describe molecular species.  This is particularly the case for 834 

one of the main components of biological pathways: proteins. Any given protein may be referred to in the 835 

literature by a number of different names concurrently. The use of non-standard nomenclature frequently 836 

leads to confusion in written texts and diagrams. If the naming of pathway components is not clear, then 837 

uncertainty arises as to what exactly is being depicted in a diagram and it ends up representing little more 838 

than a series of abstract concepts.  839 

Our models have generally been focused on human pathways and we have used standard Human Gene 840 

Nomenclature Committee (HGNC) names to label nodes representing genes and proteins 841 

(www.genenames.org). This and related nomenclature systems such as the Mouse Genome Database 842 

(MGD) standard (http://www.informatics.jax.org/mgihome/nomen/), now provide a near complete 843 

annotation of all human and mouse genes, and their use in the naming of proteins provides a direct link 844 

between the identity of the gene and the corresponding protein. Of course, not everyone has adopted 845 

these naming systems so where other names (aliases) are in common use, these names are often 846 

included as part of the node’s label after the official gene symbol in rounded brackets, but generally only 847 

on its first appearance in the pathway. Use of standard nomenclature also assists in the comparison and 848 

overlay of experimental data (which is usually annotated using standard gene nomenclature) onto 849 

pathway models. At the present time there are no standard and universally recognized nomenclature 850 

systems available for naming certain types of pathway components. For instance, protein isoforms tend to 851 

be named in an ad hoc manner by those who study them, and biochemical compounds are known by 852 

both their common names or by names that reflect their chemical composition. The IUPAC 853 

(www.iupac.org/) provides a standard nomenclature system for organic chemicals, but most names would 854 

have little relevance to a biologist. In cases such as these, the important thing is to be consistent and, 855 

where possible, to cross-reference the component’s ID to other sources such that the identity of the 856 

component depicted, where at all possible, is unambiguous. We have used the excellent ChemSpider 857 

resource (www.chemspider.com/) as a reference for the naming of biochemical entities, although other 858 

resources, e.g., ChEMBL (www.ebi.ac.uk/chembl/) are potentially equally good. Using the node 859 
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properties dialogue [F6], nodes may be hyperlinked to external web resources and additional notes to 860 

nodes can be added using in the Data tab within yEd. 861 

 862 

Protein state: The particular ‘state’ of an individual protein may determine its functional activity. With 863 

mEPN, a component’s state is indicated as a text addition to the node label using square brackets 864 

following the component’s name; each modification being placed in separate brackets. The system can 865 

be used to describe a wide range of protein modifications like phosphorylation [P], acetylation [Ac], 866 

ubiquitination [Ub] etc., and where details of the site of modification are known this may be represented, 867 

e.g., [P@L232] = phosphorylation at leucine 232.  868 

 869 

Protein complexes: Names of the components are given as a concatenation of the proteins belonging to 870 

the complex, separated by a colon. If a complex is commonly referred to by a generic name this may be 871 

shown below the constituent parts in rounded brackets. Where a specific protein is present multiple times 872 

within a complex, this may be represented by placing the number of times the protein is present within the 873 

complex in angle brackets i.e., <n>. A node representing a component may be coloured to impart visual 874 

information on the component’s type, e.g. to differentiate between a protein and a complex. Similarly, 875 

other types of pathway components may be represented using a range of shapes and colours – see 876 

palette (BOX 1, downloadable as Supplementary Data 1) for list of glyphs used to represent different 877 

entity types. A component may only be shown once in any given cellular compartment (in a given state). 878 

A component may however alter from one state to another, e.g., inactive to active, unbound to bound, in 879 

which case both forms are represented as separate entities. A different state may be indicated by 880 

including the name in square brackets, as described above. 881 

 882 

End of Box 3 883 

 884 

  885 
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BOX 4: Layout Optimisation 886 

There is a part of pathway modelling that could be considered art, or at least creative cartography. When 887 

starting a diagram the number of components is small, and visual comprehension of the system of nodes 888 

and edges is relatively easy. However, this situation soon changes as a diagram grows, and one of the 889 

greatest challenges is to render the inherently complex connections between components of a network 890 

model in a human readable form. This necessitates the careful placement of nodes and edges in the 891 

network layout. There are large number of layout algorithms available for network visualization but 892 

unfortunately none come close to the results achievable by a skilled human curator. Certain rules can be 893 

applied to this process to aid readability of the model: 894 

• Models should be constructed, where possible, along a horizontal or vertical axis, arranged top down 895 

or left to right in the direction of information flow. 896 

• Nodes should be evenly spaced and aligned along the chosen axis of layout but within the cellular 897 

compartment in which they reside. 898 

• Crossing over of edges should be kept to a minimum and changes in edges direction should be 899 

avoided when possible. When multiple edges run parallel to each other it is important to keep the 900 

lines straight to maintain an easy-to-follow diagram. 901 

• Space can be organised effectively by structuring sub-pathways into modules. 902 

• Modules of the pathway should be arranged so that the connected glyphs are in close proximity, to 903 

minimise overlapping of connective edges. 904 

• Hierarchical relationships between components should be shown in the layout of interactions. To do 905 

this, an orientation of pathway flow is chosen (e.g. left to right or top to bottom) and should be 906 

maintained throughout the diagram where possible.  907 

However, each diagram is essentially unique and each comes with its own challenges. There is no one 908 

solution that fits all models so the layout of the diagram must be able to be easily adapted to take in new 909 

components and concepts whilst maintaining its readability.  910 

 911 

End of Box 4 912 
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BOX 5: Glossary  914 

• Arc: By convention in Petri net parlance, arcs are the directional edges that connect a place to a 915 

transition or vice versa, (but never between places or between transitions). Arcs are referred to as 916 

edges in mEPN.  917 

• Edge: In mEPN notation, edge is used to refer to any line used to connect entity and process 918 

nodes to indicate an interaction (activating or inhibitory), and also the direction of that interaction. 919 

The Petri net equivalent is an arc.  920 

• Entity node: Entity nodes are glyphs that represent pathway components such as molecules or 921 

genes. The Petri net equivalent is a place. 922 

• Glyph: a visual representation of an entity, process or transition node. 923 

• GraphML: a XML-based file format used to describe the structural and visual properties of a 924 

model.  925 

• Layout: the way in which nodes and edges are set out in 2D or 3D space (physical topology). 926 

• Model: the visual representation of a network.  927 

• mEPN: modified Edinburgh Pathway Notation scheme is a graphical notation system based on 928 

the concepts of the process diagram.  929 

• Network: a number of nodes connected by edges. 930 

• Notation scheme: a system of symbols used to represent biological entities and interactions 931 

between them in a semantically and visually unambiguous manner. 932 

• Parameterization: defining the initial state of the system through the placement of tokens. 933 

• Petri net: a directed bipartite graph that alternates places (entities) and transitions (events that 934 

occur). 935 

• Place: In Petri nets, places represent possible states of the system. They are referred to as 936 

entity nodes in mEPN notation. 937 

• Process diagram: a diagram used to formally describe the components of a system, their 938 

activation state and the interactions between them. 939 
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• Process node: In mEPN notation, process nodes are glyphs that represent and define 940 

interactions between entities or the transition of an entity from one state to another. The Petri net 941 

equivalent is a transition. 942 

• SPN: Signalling Petri Net as defined by Ruths et al 37. Please note, in the context of Petri nets 943 

SPN is also often used to refer to Stochastic Petri Nets, a class of Petri net algorithms used to 944 

model the stochastic flow of tokens, as in the case here. 945 

• Tokens: Tokens represent quantitative information that is introduced and distributed through a 946 

Petri net. Here they can be thought of representing the amount and/or activity of a pathway 947 

component. 948 

• Topology: arrangement of various elements of the pathway (nodes, edges, etc.) that illustrates 949 

how information flows within the network.  950 

• Transition: In Petri nets, transitions are events or actions. They are represented as process 951 

nodes in mEPN notation. 952 

 953 

End of Box 5 954 

 955 

  956 
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Table 1: A list of resources useful for the compilation of pathway diagrams  973 

Literature Databases 
 

NCBI Pubmed http://www.ncbi.nlm.nih.gov/pubmed/ 

Web of Science http://wok.mimas.ac.uk/ 

Google Scholar http://scholar.google.co.uk/ 

Scopus http://www.scopus.com/ 

iHop http://www.ihop-net.org/ 

Component Annotation 
 

NCBI Entrez Gene http://www.ncbi.nlm.nih.gov/sites/entrez 

Gene Cards http://www.genecards.org/ 

Gene Ontology http://www.geneontology.org/GO.downloads.annotations.shtml 

PubChem http://pubchem.ncbi.nlm.nih.gov/ 

Chemspider http://www.chemspider.com 

Interaction Databases 
 

ConsensusPathDB http://cpdb.molgen.mpg.de/ 

BioGRID http://thebiogrid.org/ 

IntAct http://www.ebi.ac.uk/intact/ 

GeneMANIA http://www.genemania.org/ 

Human Protein Reference 

Database 
http://www.hprd.org/index_html  

MINT http://mint.bio.uniroma2.it/mint/Welcome.do  

STRING http://string-db.org/ 

DIP http://dip.doe-mbi.ucla.edu/dip/Main.cgi  

MIPS CORUM http://mips.helmholtz-muenchen.de/genre/proj/corum 
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Pathway Repositories 
 

KEGG http://www.genome.jp/kegg/ 

Reactome http://www.reactome.org/ 

Biocarta http://www.biocarta.com/genes/index.asp  

WikiPathways http://wikipathways.org/index.php/WikiPathways  

 974 

  975 
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